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Методические указания к лабораторным работам 

с использованием MapInfo 

Введение  

Геоинформационная система MapInfo Professional разработана 

компанией Pitney Bowes Software (США). Эта система является векторной 

универсальной ГИС и ориентирована на широкий круг пользователей. По 

многочисленным оценкам она занимает второе место в России по 

распространенности. MapInfo Professional и обладает развитыми средствами 

для решения следующих основных задач:  

• ввод атрибутивных и пространственных данных;  

• визуализация карт в различных картографических проекциях;  

• проведение пространственного анализа, включая оверлейные 

операции, построение буферных зон и т.п.;  

• создание тематических карт;  

• построение диаграмм и графиков;  

• подготовка карт к печати и др.  

Данные указания предназначены бакалаврам, обучающимся по 

программе «Информационные системы и технологии» направления 

«Информатика и вычислительная техника» для выполнения блока 

лабораторных работ по курсу «Геоинформационные системы». 



1. Лабораторная работа № 1.Работа с картой 

Цель работы 

Ознакомиться с работой пакета MapInfo, основными инструментами 

для работы с пространственными данными. Получить практический навык 

создания карты в среде MapInfo, настройки отображения и подписывания 

объектов векторных слоёв. 

1.1. Запуск пакета MapInfo Professional 

Запуск пакета MapInfo осуществляется стандартным для ОС Windows 

способом: Пуск → Все программы → MapInfo → MapInfo Professional. 

После запуска, предлагается выбрать варианты работы с пакетом (рис. 

2). На данном этапе, пользователь системы может создать новый пустой 

рабочий набор или таблицу, загрузить предыдущий рабочий набор или 

восстановить последний сеанс работы с пакетом. 

Рабочий Набор 

В Рабочем Наборе (Workspace) запоминаются имена таблиц, окна, 

вспомогательные окна и их расположение на экране. Таким образом, можно 

сохранить рабочее состояние окна MapInfo и вызвать его в следующем сеансе 

работы программы, загрузив Рабочий Набор.  

В файле рабочего набора находится последовательность команд, 

отвечающих за последовательность открытия окон. В рабочем наборе 

хранятся не сами данные, а лишь ссылки на карты, объекты, таблицы, здесь 

же сохраняются все настройки. Фактически Рабочий набор представляет 

собой скрипт, выполняя который MapInfo восстанавливает сохраненный 

ранее сеанс. 

Таблицы 

В MapInfo базы данных представлены в виде таблиц. Таблицы состоят 

двух частей. Каждая строка содержит информацию об отдельном 



географическом объекте. Каждый столбец содержит определенный вид 

информации элементов в таблице. Графические объекты таблицы 

формируют слой карты. 

1.2. Интерфейс пользователя MapInfo Professional 

 

Рис. 1. Основное окно пакета MapInfo Professional 11.5 

Основное окно пакета, как и большинство Windows-приложений, 

содержит стандартное главное меню, которое предоставляет доступ к 

большинству функций пакета.  

В области отображения представляются картографические данные.  

Панели инструментов содержат наиболее часто используемые 

команды, процедуры и инструменты.  

Окно «Управление слоями» показывает все слои, из которых состоит 

текущая карта, а так же их свойства и состояния. При помощи «Управления 

слоями» можно добавлять, удалять, переупорядочивать слои карты и 

изменять их свойства. Для того чтобы открыть данное окно необходимо 

выполнить Карта → Управление слоями (Map → Layer Control). 

Окно «Список таблиц» показывает все открытые на данный момент 

таблицы. Важно помнить, что при закрытии окна карты, все таблицы, 

использованные для создания карты, остаются открытыми в MapInfo и 

доступны через окно «Список таблиц» (Таблица → Список открытых таблиц). 



При помощи данного окна через контекстное меню таблицы можно 

просмотреть содержимое таблицы («Список»), выбрать все объекты таблицы 

(«Выбрать полностью»),при этом объекты будут выбраны как в списке 

таблицы так и на карте, так же можно открыть данные таблицы в новом окне 

карты («Открыть в новом окне карты»), изменить структуру таблицы 

(«Перестроить») и др. Для того чтобы закрыть таблицу в контекстном меню 

необходимо выбрать «Закрыть». Удобно держать данное окно открытым в 

течение всего сеанса работы. 

Помимо этого главное окно содержит строку состояния, в которой 

отображается различная вспомогательная информация, например, размер 

окна/масштаб/текущие координаты курсора, какой слой является 

изменяемым, объект какого слоя выбран в данный момент. 

1.3. Навигация по карте 

Навигация по карте осуществляется несколькими способами: с помощью 

инструментов панели «Операции», при помощи контекстного меню, при 

помощи меню «Карта», а так же при помощи клавиатуры и колеса мыши. 

Инструменты 
навигации на 

панели 
«Операции» 

Описание 

 
увеличение общего масштаба, центр переносится в координаты 

клика мыши 

 
уменьшение общего масштаба, центр переносится в 

координаты клика мыши 

 
сдвиг карты, центр карты меняется, а масштаб сохраняется 

прежним 

 
точная настройка ширины окна, масштаба и центра карты (рис. 

2) 

 
получение информации о выбранном объекте 

 
измерение расстояния между заданными пользователем 

точками в единицах измерения карты 



 

Рис. 2. Настройки отображения карты 

Обе лупы могут работать в двух режимах: режим щелчка и режим 

рамки. В последнем случае пользователь должен, не отпуская кнопку мыши, 

нарисовать рамку области приближения или отдаления карты. 

Двойной щелчок по объекту на карте выведет информацию об объекте. 

 

Рис. 3. Информация об объекте карты 

Использование колеса мыши 

прокручивание колеса — изменение масштаба карта без изменения 

координат центра карты. 

Использование клавиатуры 

Использование клавиш «+» и «–» позволяет увеличивать и уменьшать 

масштаб карты без изменения координат центра, а использование курсорных 

клавиш приводит к сдвигу карты. 

Использование команд меню «Карта» («Map») 

В меню «Карта» представлены следующие команды навигации по 

карте: «Показать по-другому», «Показать как было», «Показать слой 

полностью» (рис. 4). 



 

Рис. 4. Меню «Карта» 

Возможность возврата к предыдущему положению координат центра и 

масштаба («Показать как было») позволяет вернуться только к последнему 

состоянию перед внесением изменений. В отличие от аналогичной опции в 

ArcMap в MapInfo отсутствует возможность нескольких откатов к 

предыдущим состояниям. 

Использование контекстного меню 

В контекстном меню продублированы возможности предоставляемые 

меню «Карта». 

1.4. Описание файла слоя 

Слой представляет собой специализированный инструмент для 

отображения и работы с географическими данными. В MapInfo все слои 

представлены Но карты представляет собой картографическое изображение 

состоящее из одного или нескольких слоёв. Для управления слоями 

используется окно «Управление слоями» (Карта → Управление слоями/ Map → 

Layer control). Или при помощи кнопки  на панели инструментов. Команда 

Управление слоями  доступна, если активно окно Карты. 

При помощи данного диалогового окна можно: 

1. добавлять и удалять слои / ; 

2. изменять порядок наложения слоев простым перетаскиванием или при 

помощи кнопок ; 

3. изменять видимость слоёв ; 

4. определять доступность слоя для редактирования / ; 

5. определять доступность выбора объектов слоя / ; 

6. автоматически подписывать все объекты слоя . 



«Звёздочка» перед названием слоя, говорит об отсутствии ссылки на 

таблицу данных . 

В каждый момент времени изменяемым может быть только один слой 

карты. Если слой является изменяемым, то доступно редактирование 

графических объектов, относящихся к соответствующей таблице. На 

изменяемом слое можно рисовать, выводить текст, удалять и объединять 

объекты. 

Косметический слой 

Каждое окно карты содержит Косметический слой (Cosmetic Layer), 

располагающийся всегда поверх остальных слоёв. Изначально данный слой 

не содержит ни одного объекта. В него помещаются подписи, заголовки карт, 

различные графические объекты. Косметический слой нельзя удалить или 

переместить относительно других слоёв карты. 

 

Рис. 5. Слои карты 

Через диалог «Управление слоями» для Косметического слоя доступны 

только опции сделать слой изменяемым/неизменяемым ( / ), определить 

доступность выбора объектов ( / ) и прозрачность (Свойства слоя → 

Прозрачность). Для настройки оформления 

объектов Косметического слоя используются 

команды меню «Настройки» («Options»): Стиль 

линий (Line Style), Стиль областей (Region Style), 

Стиль символов (Symbol Style), Стиль текста (Text 

Style). 

Содержимое Косметического слоя 

пропорционально привязано к размерам карты. 



Объекты карты за исключением символов и текст на Косметическом слое 

пропорциональны масштабу карты. При изменении масштаба карты 

пропорционально изменяется и размер объектов Косметического слоя. 

Объекты косметического слоя не сохраняются после завершения 

работы пакета в отдельной таблице, и сохраняются только в настройках 

Рабочего набора. 

1.5. Добавления слоя 

Добавить слой к карте можно двумя способами при помощи меню 

«Файл» и при помощи окна «Управление слоями». В первом случае нужно 

выполнить Файл → Открыть, в паявшемся диалоговом окне выбрать тип 

файлов MapInfo (*.tab) и открыть требуемую таблицу. 

Используя окно «Управление слоями» можно добавить слой из уже 

открытых в MapInfo таблиц.  

 

Рис. 6 Добавление слоя 

Можно добавить таблицу в список открытых таблиц, не добавляя её к 

текущей карте, перетащив требуемую таблицу из папки в окно MapInfo. 

Удалённые с карты слои остаются в списке открытых таблиц и 

доступны для добавления через окно «Управление слоями» для всех 

открытых карт.  

Для того чтобы закрыть таблицу необходимо выполнить Файл → 

Закрыть таблицу. 



1.6. Режимы показа карты и слоев 

MapInfo предоставляет возможности работы с такими режимами показа 

карты как (Карта → Режимы): 

• единицы измерения расстояний и площадей; 

• проекция карты; 

• режим отображения координат и др. 

 

Рис. 7. Режимы показа карты 

Настроить отображение объектов слоя можно, используя окно 

«Свойства слоя», определив соответствующие параметры на вкладке 

«Отображение слоя». При включенном режиме Единообразно «родные» 

графические стили объектов игнорируются, и все объекты слоя 

визуализируются заданным пользователем стилем. Так же для слоя можно 

настроить прозрачность, если это необходимо. В некоторых случаях удобно 

включать режимы показа направлений линий, центроидов и узлов объектов. 



 

Рис. 8. Настройка отображения объектов слоя 

1.7. Подписывание объектов карты 

Карты передают информацию о географических объектах, но при этом 

отображение одних лишь объектов даже с помощью различных условных 

обозначений — в большинстве случаев недостаточно. Таким образом, 

большинство карт будут бесполезными, если на них не будет хотя бы 

небольшого количества текстовой информации. 

Существуют различные типы текстовой информации, которые можно 

добавлять на карту. Это может быть описательный текст, который можно 

размещать рядом с отдельными картографическими объектами. Например, 

можно подписывать столицы государств. Можно также добавить несколько 

текстовых фрагментов, чтобы обратить внимание на отдельные территории. 

И, наконец, можно добавить текст, который улучшит общее представление 

карты. Например, ниже заголовка карты можно поместить подзаголовок, в 

котором будет содержаться информация об авторе карты, источниках 

информации и дате создания. 

В MapInfo существует два способа подписывания объектов карты. 

Первый способ предполагает автоматическое создание подписей на основе 

данных об объекте и правил подписывания. Для настройки правил 

подписывания объектов слоя необходимо используя окно «Свойства слоя», 

определить соответствующие параметры на вкладке «Подписи». 



  

Рис. 9. Правила подписывания объектов слоя 

Правило подписывания включает в себя указание источника текста (Из 

колонки/ Label with) подписи, ее стиль (Стиль/ Styles) и положение 

относительно подписываемого объекта (Положение/ Placement).  

Источником текста подписи может атрибут объекта или выражение 

(вычисляемая колонка).  

Все автоматически создаваемые подписи являются динамическими и 

при изменении объектов, подписи автоматически изменяются. Однако 

пользователь может редактировать подписи, изменять их положение и стиль. 

Измененные подписи перестают быть динамическими. 

На вкладке «Правила подписывания» можно задать следующие 

правила автоматического создания подписей: 

• Запретить взаимное перекрытие подписей (Discard overlapping text); 

• При перекрытии пробовать другое положение (When overlap occurs try 

other positions); 

• Разрешить перекрытие текста (Allow overlapping text). 

А так же определить подписывать ли сегменты (Label partial objects) и 

допускать ли подписи повторяться (Allow duplicate text). 

Второй способ подписывания объектов — создание подписей вручную 

пользователь должен создавать независимые тестовые объекты, 

самостоятельно задавая позицию и текстовое содержимое подписи. Как 

правило, такие текстовые объекты хранят в отдельном текстовом слое. 



1.8. Отображение слоя в определённых масштабах 

В MapInfo все объекты видимых слоёв изначально показываются 

независимо от масштаба карты. Уменьшение масштаба может привести к 

нагромождению объектов различных слоёв друг на друга, и различать 

объекты различных слоёв, содержащие детальную информацию, будет 

затруднительно. 

 

Рис. 10. Одновременное отображение всех объектов карты при достаточно мелком 

масштабе 

Отключать и включать заново видимость слоёв на карте в окне 

«Управление слоями» при частой смене масштабов достаточно неудобно, 

особенно если карта содержит большое количество слоёв. В таком случае 

удобно чтобы включение и отключение отображения слоя на карте 

происходило автоматически. MapInfo позволяет определить для слоя 

диапазон видимых масштабов, при которых слой будет отображаться на 

карте. Таким образом, детальные слои, которые мешают чтению карты при 

мелких масштабах, будут отображаться только при достаточно крупных 

масштабах, а карта при увеличении будет представляться всё более детально. 

Для установки диапазона масштабов, при которых слой будет отображаться, 

в окне свойств слоя на вкладке «Отображение слоя» («Layer Display») 

выбрать опцию «Показывать в пределах» («Display within Zoom Range») и 

задать значения «Минимум» («Min. Zoom»), «Максимум» («Max Zoom») для 

определения минимального и максимального значений масштабов 

соответственно (рис. 11). 



 

Рис. 11. Определение диапазона масштабов видимости слоя 

1.9. Выполнение лабораторной работы 

Требуется создать карту Мексики, содержащую слои штаты, округа, 

столицы, города, дороги. 

Задание  

1. Запустить пакет Пуск → Все программы → MapInfo → MapInfo 

Professional 11.х. 

2. Создать новый пустой Рабочий набор. 

3. Добавить слои MXCTY364.TAB, MEXICO.TAB, MX_CAPS.TAB, 

MX_HIWAY.TAB, MXCTY_2K.TAB. 

4. Для всех слоёв настроить отображение объектов. 

5. Изменить имеющуюся проекцию карты на одну из подходящих для 

данного региона. 

6. Для всех слоёв настроить диапазоны масштабов видимости. 

7. Подписать объекты слоёв MXCTY364.TAB, MEXICO.TAB, 

MX_CAPS.TAB, MX_HIWAY.TAB, MXCTY_2K.TAB. Настроить 

диапазоны масштабов видимости. 

8. Сохранить полученную карту как Рабочий набор в папке, где 

расположены таблицы – источники данных. 



2. Лабораторная работа № 2. Работа с таблицами 

Цель работы 

Ознакомиться с функционалом, предоставляемым для работы с 

таблицами. Получить практические навыки работы с записями таблицы и 

редактирования таблицы. 

2.1. Понятие таблицы  

Таблица является главным функциональным объектом MapInfo. 

Таблица состоит записей, каждая из которых имеет две части: атрибутивные 

данные и пространственные данные. Количество атрибутов может быть 

произвольным, причем каждый атрибут может иметь свой тип. В этом 

смысле таблица MapInfo не отличается от обычных таблиц в СУБД. Однако в 

MapInfo таблица может иметь служебное поле, в котором хранится 

графический объект. 

 

Рис. 12. Таблица 

В MapInfo различают следующие основные виды таблиц: 

• базовая таблица; 

• связанная таблица; 

• таблица запроса; 

• растровая таблица. 



Базовая таблица 

Постоянная таблица, в отличие от таблиц запросов, которые являются 

временными. Базовые таблицы можно редактировать и изменять их 

структуру (изменяя характеристики и порядок колонок, добавляя и удаляя 

колонки и графические объекты). 

При создании запросов базовая таблица является таблицей источником 

по отношению к таблице результатов обращенного к ней запроса, которая 

является временной. В таблицы запроса нельзя вносить изменения, а также 

изменять их структуру, но доступно редактирование данных в выбранных 

записях. В большинстве случае базовые таблицы содержат атрибутивную и 

графическую части. Однако базовые таблицы могут не содержать 

графической части, данные таких таблиц не могут быть напрямую отражены 

на карте. 

Базовая таблица MapInfo на диске хранится в виде набора файлов: 

• Имя таблицы.TAB – заголовочный файл таблицы  

• Имя таблицы.DAT – файл с атрибутивными данными 

• Имя таблицы.MAP – файл с графическими данными  

• Имя таблицы.ID – индексный файл (графический)  

• Имя таблицы.IND – индексный файл (атрибутивный), данный 

файл не является обязательным. 

Связанная таблица 

Особая таблица MapInfo, которая загружается из удаленной БД и 

сохраняет связи с соответствующей таблицей удаленной БД. Со связанной 

таблицей можно производить большинство операций, применяемых к 

обычным таблицам MapInfo. В ряде случаев данные внешних таблиц могут 

быть отображены на карте. 

Таблица запроса 

Таблица запроса представляет собой временную таблицу, создаваемую 

в окне карты, списка или графика в результате операции выбора объектов 



или командами Выбрать и SQL-запрос меню «Запрос». В такие таблицы 

нельзя вносить изменения, а также изменять их структуру. Для такого рода 

таблиц возможно только изменять число выбранных записей. 

Растровая таблица 

Каждая растровая таблица состоит из двух файлов: файла растра 

(например, PHOTO.GIF) и файла таблицы (например, PHOTO.TAB). Когда 

вы изменяете внешний вид растра, MapInfo Professional сохраняет все новые 

установки в файле таблицы. MapInfo Professional никоим образом не 

изменяет сам файл, в котором хранится растр. 

2.2. Представления таблиц  

Открытые таблицы могут быть визуализированы разными способами. 

Основным способом является показ таблицы в виде слоя карты. Таким 

образом, карта, состоящая из нескольких слоев, сформирована несколькими 

таблицами. В виде слоя карты могут быть показаны обычные и растровые 

таблицы. Для показа таблицы в виде слоя карты необходимо в активной 

карте через окно «Управления слоями» добавить слой, выбрав в списке 

нужную таблицу или сформировать новое окно Карты (Окно→Новая 

Карта/Window → New Map). Атрибутивная часть обычных и внешних таблиц 

может быть представлена в табличной форме в виде окна Списка (Окно → 

Новая Список/Window → New List). Данные одной и той же таблицы могут 

быть одновременно представлены в нескольких окнах Карт или Списков. 

При этом используется механизм синхронного представления данных, т.е. 

изменение таблицы в одном из окон автоматически отображается во всех 

других. Важно, что все представления таблиц являются только способом 

визуализации данных, и закрытие окон не приводит к закрытию самих 

таблиц. И наоборот, закрытие таблицы (Файл → Закрыть таблицу/File → Close 

Table) приводит к разрушению всех созданных представлений таблицы. 



2.3. Работа со списком таблицы 

Данные всех открытых во время сеанса работы таблиц можно 

просмотреть в списке выполнив Окно → Новый список (рис. 13) или используя 

список открытых таблиц (Таблица → Список открытых таблиц) выбрать в 

контекстном меню требуемой таблицы «Список» (рис. 12). 

  

Рис. 13. Новый список Рис. 14. Список открытых таблиц 

В результате будет открыт список выбранной таблицы. 

 

Рис. 15. Список таблицы 

Для работы с данными в окне списка таблицы предлагается следующий 

функционал: 

• Меню «Сортировать» . Позволяет производить сортировку 

записей в списке, в том числе и множественную. А так е 

позволяет выполнять запросы к данным списка таблицы. 

• Опция «Применить повторно» . Позволяет применить повторно 

сортировку с указанными параметрами. Данная опция полезна 



при сортировке после внесения изменений в данные таблицы. Не 

доступна для списка таблицы запроса. 

• Меню «Выбор» . Позволяет выбрать все записи в списке, а так 

же отменить имеющийся выбор. 

• «Стиль текста» . Позволяет изменить основные параметры 

текста. 

• «Новая запись» . Добавляет пустую строку в конец списка. 

Данная опция не доступна для списка таблицы запроса. 

• «Отобрать поля» . Позволяет выбрать необходимые поля 

данных для отображения в списке таблице, поля, которые не 

были выбраны, не будут отображаться, однако останутся 

доступными (например, при создании запросов к данным 

содержащихся в них можно будет обратиться). 

2.4. Создание и редактирование таблиц 

3.4.1 Создание таблицы 

Для создания новой таблицы необходимо 

выполнить Файл → Новая таблица. Если создается 

обычная таблица, то рекомендуется после ее создания 

сразу создавать ее представление в виде слоя карты. 

При этом у создаваемой таблицы будет такая же 

проекция, как и у активной карты. Структуру атрибутов можно скопировать 

из другой таблицы или задать явно.  

При формировании названий атрибутов есть ограничения:  

• в названиях не допускаются пробелы;  

• названия не должны начинаться с цифры;  

• в названия недопустимы символы кроме цифр и букв;  

• длина названия не должна превышать 31 символ.  



 

Рис. 16. Создание структуры таблицы 

При создании таблицы с использованием структуры уже имеющейся 

таблицы так же можно добавлять новые поля и удалять уже имеющиеся. 

После того как таблица создана можно приступать к наполнению ее 

данными. Рекомендуется сначала сформировать графические объекты 

непосредственно на карте, а затем сопоставить им атрибутивные данные. Для 

создания графических объектов необходимо использовать инструменты 

панели «Пенал» («Drawing»). 

Несмотря на то, что в MapInfo допускается размещать на одном слое 

объекты разных типов, делать это не рекомендуется.  

Важной особенностью MapInfo является хранение графических стилей 

объектов непосредственно в таблицах. Поэтому при создании объектов 

можно также назначать им собственный графический стиль. 

Для сопоставления атрибутивных и пространственных данных удобно 

использовать инструмент «Информация» . С его помощью можно задавать 

значения атрибутов в специальном окне «Информация» (рис. ), просто 

указывая объект на карте. Другим способом является использования окна 

Списка. 

 

Рис.17. Окно «Информация» 



3.4.2 Редактирование таблицы 

Для редактирования структуры имеющихся базовых таблиц 

необходимо выполнить Таблица → Изменить → Перестроить и выбрать 

требуемую таблицу. Таблицы запроса являются временными и 

редактирование их структуры невозможно. 

Важно помнить, что при удалении полей данные, хранимые в них, 

будут утеряны, а при изменении типа поля потеря возможна в ряде случаев. 

Для того чтобы сохранить изменённую таблицу необходимо выполнить 

Файл → Сохранить таблицу. 

2.5. Выполнение лабораторной работы 

Требуется отредактировать таблицы созданной карты Мексики. 

Задание 

1. Для таблицы представляющей собой слой штатов Мексики: 

a. необходимо настроить отображение полей данных в списке 

таким образом, чтобы были отражены общие данные о 

штате и статистические данные за 1990 год; 

b. отсортировать данные в списке по площади штатов и 

отобразить данные таким образом, чтобы за столбцом «Имя 

штата» были расположены столбцы «Код» и «Площадь». 

2. Для таблицы представляющей собой слой дорог: 

a. добавьте поле «Длина дороги»; 

b. наполните столбец данными, полученными при помощи 

инструментария доступного для окна Карты. 

c. сохраните изменённую таблицу как базовую. 

 



3. Лабораторная работа № 3. Создание выборок 

Цель работы 

Получить практические навыки создания интерактивных выборок в 

среде MapInfo, создания атрибутивных и пространственных запросов. 

3.1 Пространственные данные 

Карты содержат огромные объемы информации. Можно очень много 

узнать о той или иной территории просто визуально изучив карту. Однако 

некоторую информацию, в большинстве случаев самую интересную и 

необходимую, нельзя получить, просто глядя на карту. Зачастую при анализе 

данных важно определить пространственные отношения между объектами. 

Для этого в MapInfo имеются несколько инструментов, которые дают 

возможность ответить на такие вопросы как «Где это находится?», «Что 

расположено ближе?», «Что находится внутри?» и т.д.  

3.2 Выбор объектов 

Выбранные на карте объекты (или записи в окне списка) образуют 

выборку (Selection). При показе выборки в виде слоя или окна списка 

создается новая временная таблица — таблица-запроса (Query). 

 

Рис. 18. Выборка 

Таблица-запроса имеет следующие особенности: 

• результирующая таблица хранится только в оперативной памяти; 



• при завершении сеанса работы  таблица удаляется, если её не 

сохранить данные пропадают; 

• содержимое таблицы (данные) зависит от базовой таблицы, на 

основе которой были созданы выборки. При закрытии базовой 

таблицы несохранённые выборки более не доступны. 

Чтобы сохранить данные необходимо сохранить таблицу Запроса Файл 

→ Сохранить Запрос. 

В MapInfo выборку можно сформировать: 

1. Инструментами выбора: 

• Выбор по одному  (при нажатой клавише Shift — 

множественный выбор); 

• Выбор в рамке ; 

• Выбор в радиусе ; 

• Выбор в полигоне  (инструментом рисуется полигон, объекты 

попавшие в данный полигон будут выбраны); 

• Выбор в области  (инструментом необходимо указать 

существующую область). 

Главное условия выбора объектов — доступность слоя, в котором они 

расположены. 

Для добавления объектов к уже имеющимся в выборке можно 

воспользоваться клавишей Shift. 

Для просмотра информации о выбранных объектах необходимо 

выполнить Окно → Новый список → Имя таблицы Запроса (по умолчанию 

Selection). 

При этом существует возможность инвертировать выбор .  

Для отмены выбора необходимо воспользоваться инструментом . 



 

Рис. 19. Выбранные объекты слоя  

3.3 Простые запросы 

Простые запросы выполняются по одной таблице. Для создания 

простого запроса необходимо выполнить Запрос → Выбрать.  

 

Рис. 20. Простой запрос 

Созданный запрос можно сохранить («Сохранить»/ «Save»), а так же 

загрузить уже имеющийся («Загрузить»/ «Load»). 

Условие для создания выборки можно ввести вручную, а можно 

составить, используя окно «Выражение»/ «Expression» (кнопка «Составить»/ 

«Assist»). После того как выражение было составлено, можно проверить его 

корректность (кнопка «Проверить»/ «Verify»). 

 

Рис. 21. Условие запроса 



При составлении условия следует учитывать типы полей (колонок), 

участвующих в запросе. Если поле числовое, то допустимы арифметические 

операторы (+, –, /, * и др.) и операторы сравнения (>, <, =, <> и др.). Если 

поле строковое, то допустимы операторы сравнения (>, <, =, <> и др.), 

арифметический оператор «+», строковый оператор Like и строковые 

функции. В запросе можно указывать константы: числовые константы 

указываются непосредственно (Summa>1000000); строковые константы 

указываются в кавычках (Название = «Томская»). 

Результат выполнения запроса будет помещён в таблицу с именем, 

указанным в строке «Результат в таблицу» («Store Results in Table»). 

Изначально задано стандартное имя — «Selection». При использовании 

стандартного имени результирующей таблицы автоматически будут 

создаваться временные таблицы «Query1», «Query2» и т.д. 

Временная таблица может быть сохранена и отображена на карте: 

1. Выполнить Файл → Сохранить Запрос (File → Save Query). 

2. В появившемся диалоговом окне выбрать требуемую таблицу 

Запроса и выбрать «Сохранить как». 

Для отображения данных на карте: 

3. Выполнить Файл → Открыть. 

4. В окне «Управление слоями» добавить сохранённую таблицу к 

слоям карты. 

Важно помнить, что сохранённая таким образом таблица не является 

базовой, и представляет собой таблицу-запроса. Такие таблицы не могут 

использоваться в SQL-запросах. Для того чтобы сохранить результат запроса 

как базовую таблицу необходимо выполнить Файл → Сохранить копию (File → 

Save Copy As). 

  



Примеры простых запросов 

 

Найти все штаты с численностью населения 

(от 16 до 64) более 3 000 000. 

 

 

 

 

Найти все штаты, в которых мужчин 

проживает больше чем женщин. 

 

 

Найти все штаты, в которых проживает 

свыше 500 000, но менее 1 000 000 детей и 

подростков в возрасте до 15 лет. 

 

 

Для сортировки результатов запроса по значениям интересующего поля 

атрибутивных данных необходимо выбрать в выпадающем списке 

«Упорядочить по колонке» («Sort Results by Column») имя колонки, по 

величинам которой будет проведена сортировка. 

Для того чтобы результат был показан в таблице необходимо выбрать 

«Результат в список» («Browse Results»), для того, чтобы объекты были 

выделены на карте необходимо выбрать «Показать результат в текущем окне 

карты» («Find Results In Current Map Window»). 

3.4 SQL-запросы 

SQL-запросы выполняются по одной или нескольким таблицам. Для 

выполнения SQL-запроса меню Запрос → SQL-запрос.  



Порядок действий при составлении SQL-запроса (если анализируется 

несколько таблиц):  

1. Выбрать таблицу, записи которой необходимо найти. 

2. Выбрать таблицу, с записями которой необходимо выполнить 

сравнение. 

3. Выбрать колонки, которые необходимо включить в результат (по 

умолчанию используются все колонки — *). 

4. Ввести условие.  

 

Рис. 22. SQL-запрос 

SQL-запросы позволяют находить объекты, не только используя 

атрибутивные данные, но и объекты, находящиеся в определённых 

пространственных отношениях. Географические (пространственные) 

операторы, используемые для поиска объектов в MapInfo, представлены в 

таблице 1. 

Таблица 1. Виды пространственных отношений 

Вид 

пространственных 

отношений 

Объекты 

Contains («Содержит») Объект A содержит объект Б, если центроид Б лежит в 

границах A. 



Contains Entire 

(«Полностью содержит») 

Объект A полностью содержит объект Б, если граница Б 

полностью лежит внутри границ A. 

Contains Part (« Частично 

содержит») 

Объект A полностью содержит объект Б, если границы 

объекта Б частично лежат внутри границ объекта А. 

Within («Внутри») Объект A лежит внутри объекта Б, если его центроид лежит в 

границах Б. 

Entirely Within 

(«Полностью внутри») 

Объект A лежит полностью внутри объекта Б, если его 

граница полностью лежит внутри границ Б. 

Intersects («Пересекает») Объект A пересекается с объектом Б, если они имеют хотя бы 

одну общую точку. 

Для обращения к объекту слоя необходимо в выпадающем списке 

выбрать «Имя слоя.obj» («Layer name.obj»). При запросе только к одной 

таблице — obj. 

Географические (пространственные) функции, используемые для 

поиска объектов в MapInfo, представлены в таблице 2. 

Таблица 2. Пространственные функции 

Вид 

пространственных 

функций 

Возвращаемое значение 

Area(obj,str) Возвращает площадь объекта. Параметр str задает единицы 

измерения, такие как «sq mi» и «sq km». 

CentroidX(obj) Возвращает X-координату центроида. 

CentroidY(obj) Возвращает Y-координату центроида. 

Distance(num_x,num_y, 

num_x2,num_y2,str) 

Возвращает расстояние между двумя точками, заданными 

координатами. Параметр str задает единицы измерения, такие 

как «mi» и «km». 

ObjectLen(obj,str) Возвращает длину объекта. Параметр str задает единицы 

измерения, такие как «mi» или «km». Только объекты типа 

«дуга», «линия» и «полилиния» имеют ненулевую длину. 

Perimeter(obj,str) Возвращает периметр объекта. Параметр str задает единицы 

измерения, такие как «mi» или «km». Только объекты типа 

«эллипс», «область» и «прямоугольник» имеют ненулевую 

длину. 

В MapInfo используются следующие логические операторы:  



• And. Принимает значение TRUE («истина») только в том случае, 

если оба ее аргумента (логические выражения) истинны. То есть 

запись должны удовлетворять обоим условиям, чтобы попасть в 

выборку. 

• Or. Принимает значение TRUE («истина»), если один или оба ее 

аргумента (логические выражения) истинны. То есть запись 

должны удовлетворять хотя бы одному из условий, чтобы 

попасть в выборку. Записи также выбираются, если 

удовлетворяют обоим условиям. 

• Not. Принимает значение TRUE «истина», если аргумент имеет 

значение FALSE («ложь»). То есть записи не должны 

удовлетворять условию, чтобы попасть в выборку. 

3.5 Выполнение лабораторной работы 

Используя атрибутивные («Выбрать») и SQL-запросы необходимо 

ответить на вопросы, приведённые в задании. 

Задание  

1. По территории каких штатов проходит самая протяжённая дорога. 

2. Для каждого из данных штатов количество городов. 

3. Отсортировать полученные результаты по площади и протяжённости 

границ данных штатов. 



4. Лабораторная работа № 4. Работа с объектами 

Цель работы 

Ознакомиться с функционалом MapInfo, предоставляемым для 

редактирования и создания объектов. Получить практические навыки работы 

с инструментами создания и редактирования объектов. 

4.1. Редактирование объектов 

В MapInfo реализовано множество функциональных возможностей 

создания, редактирования и комбинирования объектов. 

Возможность редактирования объектов слоя становится доступна, если 

слой является изменяемым ( ). 

Для редактирования объекта необходимо:  

1. Выделить объект инструментом ; 

2. Сделать слой, в котором находится этот объект, изменяемым. Для 

определения слоя, в котором находится выбранный объект см. 

строку состояния.  

3. Для изменения положения объекта используется 

непосредственное перетаскивание мышкой. 

4. Для изменения размеров объекта необходимо воздействовать на 

угловые квадраты.  

5. Для поузлового редактирования необходимо перейти в режим 

формы . 

4.2. Поузловое редактирование объектов 

Добавлять узлы можно только для линий, полилиний и областей. 

Добавить дополнительный узел можно используя инструмент , для 

удаления созданного узла используется Правка → Отменить добавление узла 

(Edit →Undo Node Addition). Стоит помнить, что будет удалён только 

последний добавленный узел. 



Максимальное количество узлов для областей и полилиний составляет 

1048572 узлов. С появлением каждых двух новых полигонов этот предел 

сокращается на семь узлов. 

Чтобы добавить узел: 

1. В режиме редактирования поместить указатель мыши в точку на 

сегменте, в которой нужно добавить узел. 

2. Щелкнуть клавишей мыши – узел будет добавлен.  

3. Для сохранения добавленного узла необходимо выполнить команду 

Правка → Новая запись (Edit →New Row), к концу таблицы будет 

добавлена новая запись. 

Для добавления узлов в местах пересечения объектов необходимо 

выполнить следующие действия: 

1. Выбрать один или несколько объектов на изменяемом слое карты, к 

которым необходимо добавить узлы. 

2. Для выбранных объектов выполнить команду Объекты → выбрать 

изменяемый объект (Objects→Set Target), после выполнения команды 

объекты будут отображаться другим стилем, чтобы указать, что они 

теперь являются изменяемыми (рис. 23). 

 

Рис.23. Изменяемый объект 

3. Затем необходимо выбрать объекты в изменяемом слое, которые 

пересекают изменяемый объект и выполнить команду Объекты → 

Добавить узлы (Objects→Overlay Nodes). MapInfo создаст узлы в 

изменяемых объектах, если это возможно. 



Для удаления узла необходимо выделить узел и нажать клавишу Delete 

Для изменения положения узлов необходимо прейти в режим  

(Правка →Форма/ Edit → Reshape). Далее необходимо выбрать объект узлы 

которого будут редактироваться. 

Внесённые изменения фиксируются в таблице. Для того чтобы 

вернуться к исходному состоянию объекта необходимо восстановить 

таблицу, выполнив команду Файл → Восстановить таблицу (File→Revert Table).  

При отказе от внесённых изменений будут отменены все внесённые 

изменения, включая настройки стилей объектов слоя. 

4.3. Редактирование графического стиля объектов 

Для редактирования графических стилей объектов используется панель 

«Пенал»/ «Drawing»: 

• изменение стиля символа ; 

• изменение стиля линии ; 

• изменение стиля полигона ; 

• изменение стиля текста . 

Так же перейти к редактированию стиля можно вызвав окно свойств 

двойным щелчком и нажать кнопку «Стиль». 

4.4. Создание объектов 

Создавать объекты можно с помощью инструментов панели «Пенал»/ 

«Drawing»: 

• точечный объект ; 

• линия ; 

• полилиния ; 

• дуга ; 

• полигон ; 



• эллипс, окружность ; 

• прямоугольник ; 

• скруглённый прямоугольник ; 

• текст . 

4.5. Комбинирование объектов 

Комбинирование объектов слоя так же возможно только в изменяемом 

слое. 

Объединение объектов  

  

Рис. 24. Исходные объекты (слева) и результат объединения (справа) 

1. Выделить объекты (A и B)  

2. Команда Объекты → Объединить (Objects → Combine). 

 

Рис. 25. Обобщение данных объединяемых объектов 

В графе метод необходимо задать каким образом будут объединены 

данные. 

Удаление части объекта  

1. Выделить объект, который будет обрезаться (A). 



2. Команда Объекты → выбрать изменяемый объект (Objects→Set 

Target). 

3. Выделить объект, которым будем обрезать (B). 

4. Команда Объекты → Удалить часть (Objects → Erase). 

  

Рис. 26. Исходные объекты (слева) и результат операции (справа) 

Удаление внешней части объекта (пересечение)  

1. Выделить объект, который будет обрезаться (A). 

2. Команда Объекты → выбрать изменяемый объект (Objects→Set 

Target). 

3. Выделить объект, которым будем обрезать (B). 

4. Команда Объекты → Удалить внешнюю часть (Objects → Erase 

Outside). 

  

Рис. 27. Исходные объекты (слева) и результат операции (справа) 

Также возможны следующие модификации изменяемых объектов: 

• Оконтурить объекты (Объекты → Оконтурить объекты/Objects → 

Convex Hull). 

• Замкнуть (Объекты → Замкнуть/ Objects → Convert to regions). 

• Конвертировать объект в полилинию (Объекты → Замкнуть/ 

Objects → Convert to Polylines). 

• Разрезать объект (Объекты → Замкнуть/ Objects → Split). 

• Разрезать объект полилинией (Объекты → Замкнуть/ Objects → 

Polyline Split).  



При комбинировании объектов можно назначать несколько 

изменяемых объектов, а также выбирать несколько влияющих объектов. 

4.6.  Буферные зоны 

Для построения буферной зоны необходимо:  

1. Выделить объект(ы), для которого строится буферная зона. Буферная 

зона формируется в виде нового объекта(ов) и заносится в 

изменяемый слой. 

2. Команда Объекты → Буферные зоны (Objects → Buffer). 

 

Рис. 28. Параметры буферной зоны 

Буферные зоны можно создавать как для одного объекта, так и для 

нескольких объектов. Буферы можно создавать индивидуально для каждого 

выделенного объекта или один для всех. 

Примеры буферных зон: 

 

Рис. 29. Буферные зоны 

При создании буферных зон MapInfo рассчитывает ширину буферной 

зоны, измеряя ее от внешней линии объекта. При использовании данных в 

проекции "Широта/Долгота", ширина буфера, заданная в десятичных 



градусах той же проекции, может изменяться в различных частях объекта. 

Это происходит потому, что ширина задается в плоских единицах измерения 

(км, м), а десятичные градусы имеют различную длину в зависимости от 

местоположения на поверхности Земли. Например, 1 км недалеко от полюса 

соответствует большему числу градусов долготы, чем на экваторе. 

MapInfo вычисляет ширину в десятичных градусах для центра 

прямоугольника, описывающего объект. Таким образом, расстояние, 

измеренное на поверхности Земли (на сфере) от границы объекта до границы 

нового буферного объекта, может значительно изменяться от узла к узлу. Для 

маленьких объектов этим можно пренебречь. Для объектов большой 

протяженности, например, таких как объект Россия на карте мира, различия в 

расстояниях могут быть значительны. 

При создании буферной зоны для нескольких объектов одновременно 

данные объектов объединяются. 

4.7. Выполнение лабораторной работы 

Задание 

1. Для карты Мексики на основании имеющихся штатов создать 

единый объект и поместить его в новый слой «Страны» (Countries). 

Соответствующую таблицу необходимо сохранить с другим именем 

и добавить к имеющимся слоям карты (работать нужно с новым 

слоем, чтобы на карте были и штаты и страна в целом). 

2. Рассчитайте площадь подтопления штата Baja California Sur, если 

известно, что подтоплена трехкилометровая прибрежная зона. 

(Допущение: подтопление по всей береговой линии). 

3. Территорию штата, избежавшую подтопления, выделить на карте 

визуально (изменить графический стиль отображения). 

 



5. Лабораторная работа № 5. Создание тематических 

карт 

Цель работы 

Ознакомиться с видами тематических карт, создаваемых в MapInfo, 

получить практические навыки их создания. 

5.1 Понятие тематической переменой  

Тематическая переменная — переменная, используемая в процедуре 

создания тематического слоя. Для каждого объекта принимает значение, 

равное значению соответствующей записи в определенном поле или 

значению, полученному вычислением значений полей из этой записи. Во 

втором случае необходимо в списке полей выбрать «Выражение»/ 

«Expression» и в появившемся одноимённом диалоговом окне на основании 

полей таблицы составить выражение — вычисляемая колонка. Выбрав 

«Объединение»/ «» возможно использовать пространственные отношения с 

другой таблицей. 

5.2 Принципы построения тематических карт  

Способ отображения данных на карте определяет её информативность 

и наглядность. В зависимости от вида и назначения карты объекты могут 

быть отображены различными способами. Одним из способов представления 

является тематическая картография, т.е. оформление карты в соответствии с 

какой-либо темой. 

В MapInfo под созданием тематической карты понимается процесс 

формирования нового тематического слоя на основании данных, 

содержащихся в таблицах. Тематический слой представляет собой 

дополнительный слой, который содержит тематические объекты. Для одного 

исходного слоя можно сформировать несколько тематических слоев, 

отражающих разные явления. Тематический слой является динамическим, т.е. 



при изменении данных в исходном слое, тематический слой автоматически 

обновляется.  

Для создания тематической карты необходимо выполнить команду 

Карта → Создать тематическую карту. В результате будет открыто окно 

мастера создания тематической карты. 

 

 

 

Рис. 30. Мастер создания тематической карты 

На первом шаге мастера необходимо задать метод построения 

тематической карты и выбрать шаблон оформления. На втором шаге нужно 

выбрать исходный (базовый) слой, на основе которого будет создаваться 

тематический, и задать тематическую переменную. На третьем шаге задается 

графическое оформление слоя, и уточняются параметры тематического слоя. 

5.3 Виды тематических карт 

В MapInfo имеются следующие способы отображения данных на карте: 

 Диапазоны — данные отображаются в соответствии с 

установленными пользователем диапазонами значений тематической 

переменой.  

 Карты размерных символов — этот метод применяется для 

выделения объектов символами разных размеров. 

 Столбчатые диаграммы — столбчатые диаграммы 

используются для анализа нескольких топографических переменных.  



 Круговые диаграммы — метод круговых диаграмм 

используется для анализа более чем одной ТП. Каждый сектор диаграммы 

соответствует одной ТП, а его угол пропорционален значению ТП для 

данного объекта. 

 Карты плотности точек — этот метод выделения применим 

только для областей. В такой тематической карте каждая область заполняется 

точками, число которых пропорционально выделяемым значениям. 

Например, так можно выделить области, используя данные о населении. 

 Карты отдельных значений — объекты карты раскрашиваются 

в соответствии с индивидуальными значениями. Метод полезен в том случае, 

когда нужно подчеркнуть различие категорий, на которые можно разбить 

данные (например, типы магазинов в заданной области, классификация зон в 

заданной области). 

 — тематическая карта поверхности представляет собой 

непрерывную растровую поверхность, полученную путем интерполяции 

точечных данных. 

5.4 Карта диапазонов 

Карты диапазонов часто используются для демонстрации взаимосвязи 

между значениями данных и географической площадью (например, объем 

продаж, доход с недвижимости) или для представления относительной 

информации, такой как плотность населения (численность населения на 

единицу площади). 

При создании тематических карт методом диапазонов, MapInfo 

группирует записи с близкими значениями тематической переменной и 

присваивает созданным группам единый цвет/тип штриховки, тип символа 

или линии. 



 

Рис. 31. Карта диапазонов 

Для создания карты диапазонов необходимо выбрать в мастере 

объектов соответствующий тип. Далее выбрать один из предложенных 

шаблонов. Следующим шагом необходимо выбрать данные, на основании 

которых будут создаваться диапазоны: таблицу и поле в выбранной таблице 

или выражение. При выборе пункта «выражение» появится окно составления 

выражения (рис. 21). 

На последнем шаге можно настроить диапазоны (метод разбиения, 

число диапазонов и число до которого округлить граничные значения 

диапазонов), настроить стили отображения диапазонов, а так же легенду. Все 

внесённые изменения можно сохранить в виде нового шаблона (панель 

«Шаблон» → Сохранить как). Данная возможность существует для всех 

видов тематических карт. 

4.4.1 Типы диапазонов 

В MapInfo существуют следующие способы задания диапазонов: 

• равное количество записей; 

• равный разброс значений; 

• естественные группы; 

• на базе дисперсии; 

• квантили; 

• вручную. 



 

Рис. 32. Насройка диапазонов 

Метод «Равное количество записей» создает диапазоны с одинаковым 

количеством записей в каждом из них.  

Метод «Равный разброс» разделяет записи на группы с равными 

диапазонами значений.  

Методы «Естественные группы» и «Квантили» позволяют 

анализировать неравномерно распределенные данные. 

Метод «Естественные группы» создает диапазоны в соответствии с 

алгоритмом, использующим среднее внутри каждого диапазона. Этот метод 

распределяет данные так, что среднее значение в каждом диапазоне наиболее 

близко к каждому значению в этом диапазоне. Это обеспечивает наилучшее 

представление диапазонов своими средними значениями, а так же благодаря 

этому данные внутри каждого диапазона, оказываются наиболее приближены 

друг к другу. 

Метод «Квантили» позволяет строить диапазоны, определяющие 

распределение тематической переменной по некоторому сегменту данных. 

Например, можно применить режим «Квантили» к населению области по 

отношению к численности городского населения, чтобы показать, как 

распределено городское население на территории определённого региона. 

Метод «На базе дисперсии» позволяет определить диапазоны 

следующим образом: средний диапазон разбивает данные по среднему 



значению так, что диапазоны выше и ниже среднего диапазона отстоят от 

него на единицу стандартного отклонения. 

5.5 Карты размерных символов 

На тематических картах данного типа используются символы разного 

размера для показа различных значений исходных данных. Размерные 

символы используются для представления количественных данных Метод 

размерных символов можно использовать для любых типов графических 

объектов на карте. Выделяться могут как точечные объекты, так и других 

типов. В последнем случае символы помещаются на место центроида 

объекта. Размер символов меняется пропорционально значению 

тематической переменной. 

 

Рис. 33. Карта размерных символов 

Для создания карты размерных символов необходимо выбрать 

соответствующий тип, выбрать данные для отображения и настроить стиль 

символов. Можно выбрать подходящий по тематике символ, определить 

размер максимального символа, определить цвет символов. 

В MapInfo существует возможность отображать и отрицательные 

значения, для отображения таких данных символы настраиваются отдельно. 

В результате на карте будут отображены и те и другие символы. 



 

Рис. 34. Настройка символов 

5.6 Столбчатые диаграммы 

Данный вид тематических карт используется для представления 

нескольких тематических переменных одновременно. Столбчатые 

диаграммы, как правило, используются для наглядного сравнения 

полученных статистических данных или для анализа их изменения за 

определённый промежуток времени.  

Данные отображаются на карте в виде столбчатых диаграмм, где 

каждый столбец соответствует одной тематической переменной, а его высота 

пропорциональна значению для данного объекта. На такой карте для каждого 

картографического объекта строится своя столбчатая диаграмма, которая 

привязывается к центроиду данного объекта и позволяет сравнивать значения 

нескольких характеристик, изображенных столбцами разного размера для 

одного объекта. Также можно прослеживать изменения одного показателя на 

карте для разных объектов. 

 

Рис. 35. Столбчатые диаграммы 



Для создания карты размерных символов необходимо выбрать 

соответствующий тип. Следующим шагом необходимо выбрать данные для 

отображения (рис. ) 

 

Рис. 36. Выбор данных 

Для представления столбчатых диаграмм можно задать такие 

параметры как: 

• цвет каждого столбца; 

• цвет и тип границы; 

• ориентацию столбцов: вертикальная/горизонтальная; 

• сдвиг диаграммы по отношению к центроиду объекта: 

непосредственно в точке центроида (стандартный режим) или 

еще в восьми возможных позициях; 

• для разных параметров можно задавать свой, независимый, 

масштаб столбцов; 

• для более наглядного представления диаграмм на карте можно 

задать фон для диаграмм. 

В случае отрицательных значений, столбцы направлены в 

противоположном, относительно ориентации диаграммы, направлении. 

Отрицательные значения не будут отображаться на столбчатых диаграммах в 

формате стопки. 

5.7 Круговые диаграммы 

Представление данных при помощи столбчатых диаграмм позволяет, 

так же как и использование столбчатых диаграмм, анализировать значения 



нескольких тематических переменных одновременно. Круговые диаграммы 

используются для представления долей каждой величины в общем объёме. 

Так, например, данный вид диаграмм можно использовать для представления 

национального состава населения региона. Наглядность представления 

данных в виде круговой диаграмм зависит от количества частей 

совокупности. С увеличением числа тематических переменных, которые 

должны быть отображены, наглядность диаграммы снижается. Для 

достижения наилучших результатов при анализе рекомендуется использовать 

не более 4 – 6 сегментов на диаграмму. 

 

Рис. 37. Круговые диаграммы 

Для представления круговых диаграмм можно задать такие параметры 

как: 

• цвет каждого сегмента; 

• тип границ секторов; 

• тип границ диаграммы; 

• задавать угол, определяющий начальное положение первого 

сектора диаграммы; 

• определять порядок следования секторов: по/против хода 

часовой стрелки; 

• определять положение диаграммы (стандартное положение — 

точка центроида); 

• градуировать; 



• представлять данные в виде полукруга. 

Установив флаг «Градуировать» позволяет учитывать изменения в 

исходных данных для диаграммы, т.е. размер секторов на круговой 

диаграмме будет изменяться в зависимости от суммы значений ее 

компонентов. 

Флаг «Полукруг» позволяет показывать данные в режиме, при котором 

сектора выделяются из полукруга, а не из полного круга. 

5.8 Карты плотности точек 

Применение точечного способа отображения данных является одним из 

способов показа плотности распределения объектов или явлений на 

интересующей территории. Метод плотности точек применяется в тех 

случаях, когда нужно показать распространение какого-либо явления, 

неравномерно распределенного по площади. Для отображения данных 

используются точки, точке сопоставляется количественное значение (вес). 

Общее число точек внутри каждой из областей отображает значение, которое 

соответствует этой области. 

Карты плотности точек целесообразно использовать в случаях, когда 

исходные данные не привязаны к определенному месту внутри области 

(например, численность населения). 

 

Рис. 38. Карта плотности точек 



При создании карты плотности точек после выбора исходных данных 

вес точки определяется автоматически. Но может быть изменён 

пользователем в зависимости от поставленной задачи. Так же помимо веса 

точки могут быть определены такие параметры как форма точки 

(круг/квадрат), размер (от 2 до 25 пикселей) и цвет. 

 

Рис. 39. Настройка карты плотности точек 

Уменьшение веса точки увеличивает их число на карте и наоборот.  

При небольшом количестве отображаемых на карте точек 

целесообразно увеличить их размер. 

Применяя различные цвета точек, становится возможным создать 

одновременно несколько карт плотности в одном окне карты. 

5.9 Карты отдельных значений 

Представление данных при помощи метода отдельных значений 

позволяет выделять на карте точечные, линейные и площадные объекты по 

отдельным значениям из заданного поля таблицы. Выделение можно 

производить как по числовым, так и по нечисловым значениям. MapInfo 

автоматически присваивает каждому значению свой цвет или символ. 

Символы, присваиваемые значениям, выбираются из базовой таблицы. 



 

Рис. 40. Карта отдельных значений 

5.10 Регулярная поверхность 

Тематическая карта поверхности представляет собой непрерывную 

растровую поверхность, полученную путем интерполяции точечных данных. 

MapInfo берет данные из колонок таблицы или вычисляет выражения, и 

передает центроиды и значения данных, в модуль интерполяции. В 

результате интерполяции создается растровый файл поверхности, который 

появляется как растровая таблица в окне карты. 

Карта поверхности отображает данные, как непрерывные цветовые 

градации на карте. Этот тип тематического оформления получается путем 

интерполяции точечных данных из таблицы-источника. Файл поверхности 

генерируется модулем интерполяции и отображается как растровое 

изображение в окне карты. 

5.11 Комплексные карты 

В ряде случаев есть необходимость представить несколько 

тематических переменных на одной карте. В таком случае можно создать 

комплексную карту. В MapInfo возможно создать несколько различных 

тематических карт для одного слоя. Для создания комплексных карт 

отдельно настраивается отображение объектов интересующих слоёв в 

соответствии с решаемой задачей. 



5.12 Создание легенды карты 

Легенда является одним и основных элементов карты. Легенда 

представляет собой список или таблицу условных обозначений 

используемых на карте с разъяснением их значения. 

Для создания легенды необходимо выполнить Карта → Создать легенду. 

 

  

Рис.41 . Выбор слоёв 
Рис. 42. Определение имен 

легенды и стилей подписей 

Рис. 43. Определение свойств 

раздела 

Первым шагом необходимо выбрать слои, условно графические 

обозначения (УГО) объектов которых должны быть внесены в легенду карты. 

Важно отметить, то для внесения в легенду доступны только УГО объектов 

отображаемых на карте, т.е. в списке слоёв не будут представлены слои, 

видимость которых отключена, а так же те слои, объекты которых не 

показываются при текущем масштабе окна карты (для объектов слоёв 

настроены границы видимости). Вторым шагом задаётся имя окна легенды, и 

настраиваются стили подписей различных уровней. Последним шагом 

необходимо настроить разделы легенды. На данном этапе задаётся имя 

раздела, стили отображения объектов и подписей. По умолчанию заголовок 

раздела представлен так «Имя слоя Легенда». В результате будет создана 

легенда карты в отдельном окне. 

http://ru.wikipedia.org/wiki/%D0%9A%D0%B0%D1%80%D1%82%D0%B0


 

Рис. 44. Легенда карты 

Легенда карты является динамической, т.е. изменение стиля объектов 

слоя будет автоматически отображено в легенде. Однако изменение 

видимости слоя не влечёт автоматического удаления или добавления раздела. 

Для добавления раздела необходимо выполнить Конструктор легенды → 

Добавить раздел. Для удаления раздела необходимо выделить раздел в окне 

легенды и в контекстном меню выбрать «Удалить выбранные разделы». 

Для того, чтобы изменить отображение данных в разделе необходимо в 

контекстном меню выбрать «Свойства» или дважды щёлкнуть по 

интересующему разделу. 

 

 

Рис. 45. Свойства раздела легенды объектов 

базового слоя 

Рис. 46. Свойства раздела легенды объектов 

тематического слоя 

5.13 Сохранение тематической карты 

Так как тематические слои являются динамическими, и не хранятся в 

виде файлов, то единственная возможность сохранить тематическую карту 



для дальнейшей работы — сохранение Рабочего набора. В нем записывается 

источник тематической карты и правило создания и оформления 

тематического слоя. 

5.14 Настройка тематической карты 

Созданный тематический слой можно изменить. Для изменения 

доступны графические стили, параметры разбиения на диапазоны, 

пропорции диаграмм и символов. Для тематического слоя невозможно 

изменить тип и тематическую переменную. Если возникла такая 

необходимость, следует создать новый тематический слой. 

Для изменения настроек тематической карты необходимо выполнить 

команду Карта → Настройка тематической карты или дважды щелкнуть по 

тематическому слою в окне «Управление слоями».  

Посредством данного диалогового окна можно также изменять 

настройки легенды, в том числе перейти к окну настроек легенды 

(«Легенда»/ «Legend»). 

5.15 Выполнение лабораторной работы 

Требуется создать два макета карты Мексики, отражающие данные о 

плотности населения штатов и отражающие основные статистические 

характеристики. Использовать для отображения плотности населения штатов 

Мексики размерные символы диапазоны и плотность точек, а для 

отображения основных статистических характеристик штатов использовать 

столбчатые и круговые диаграммы.  

 



 

 



6. Лабораторная работа № 6. Работа с растровыми 

изображениями 

Цель работы 

Получить практические навыки пространственной привязки растрового 

изображения в среде MapInfo. 

6.1. Растровые изображения 

Растровые изображения, используемые в ГИС — это, как правило, 

данные, которые могут быть представлены как пространственные. На растрах 

могут быть отображены географические объекты путем разделения 

пространства на регулярную структуру отдельных ячеек, называемых 

пикселем. Каждый пиксель (элемент рисунка) представляет область, как 

правило, имеющую географическое расположение, и содержит значение, 

описывающее представляемый объект. Так значения пикселей на 

аэрофотоснимке представляют количество света, отраженного от участков 

земной поверхности, интерпретируемых как деревья, дома, улицы и т.д., а 

значения пикселей на цифровой модели рельефа представляют высоты.  

Растры могут представлять: 

• тематические данные (землепользование, типы почв и т.д.); 

• непрерывные данные (температура, рельеф и т.д.); 

• спектральные данные (космические снимки и аэрофотоснимки); 

• различные изображения, например сканированные карты, 

сканированные рисунки или фотографии зданий.  

Как правило, отображаются тематические или непрерывные растры как 

слои данных, вместе с другими географическими данными карте. Растровые 

изображения, отображаемые вместе с географическими данными, могут 

передавать дополнительную информацию об объектах на карте. Также 

можно отобразить слой данных, представленный совокупностью наборов 

растровых данных, называемой каталогом растров. 



MapInfo является векторной ГИС, но предусматривает возможность 

работы с растровыми данными. Однако для работа с растровыми 

изображениями ограничена средствами визуализации. 

В MapInfo все растры делятся на координатно-привязанные 

(зарегистрированные) и обычные (не зарегистрированные). 

Зарегистрированные растры могут совмещаться с векторными данными, по 

ним могут выполняться различные пространственные измерения. Не 

зарегистрированные растры, например, фотографии, можно просто 

просматривать. 

6.2. Регистрация растрового изображения 

Под регистрацией растрового изображения понимается процесс 

соотнесения растровых координат растра и их мировых координат. Для 

регистрации растрового изображения необходимо выполнить команду Файл 

→ Открыть (File → Open) и в диалоге выбора файла выбрать тип файлов 

«Растр»/ «Raster» и выбрать требуемое изображение. Далее выбрать вариант 

Регистрировать (Register). 

 

Рис. 49. Выбор режима работы с растром 

Суть регистрации состоит в задании на изображении контрольных 

(реперных) точек, для каждой из которых необходимо задать растровые и 

мировые координаты. Растровые координаты ГИС формирует 

автоматически. Для задания мировых координат рекомендуется использовать 

точки пересечения координатных линий или точки с известными мировыми 

координатами.  



 

Рис. 50. Регистрация растра 

Для координатной привязки растра необходимо минимум три точки. 

Однако для того, чтобы убедиться в корректности привязки необходимо 4 и 

более точки. В этом случае ГИС вычисляет ошибку привязки в реперных 

точках. Задача пользователя состоит в том, чтобы эта ошибка не превышала 

нескольких пикселей.  

Для того, чтобы добавить новую контрольную точку необходимо 

выбрать «Добавить»/ «Add». Если просто курсором указать на растре 

местоположение, то туда будет перенесена текущая точка. 

 

Рис. 51. Добавление контрольной точки 

При добавлении контрольной точки необходимо указать имя точки и 

координаты на карте, в единицах измерения карты. 



Для редактирования значения точки необходимо выбрать её в списке и 

выбрать «Правка»/ «Edit» или открыть диалог двойным щелчком по 

интересующей точке. 

Крайне важно при привязке верно задать проекцию растра. Проекция 

регистрируемого растра задаётся при помощи диалога «Выбор проекции» 

(кнопка «Проекция»/ «Projection»). Проекция растра должна совпадать с 

проекцией карты. 

Если после регистрации растра обнаружены ошибки привязки, то их 

можно исправить командой Таблица → Растр → Регистрация изображения. 

6.3. Настройки отображения растровых слоев  

К настройкам отображения растровых слоев относятся:  

• Настройка видимости слоя 

Для настройки видимости слой необходимо использовать окно 

«Управление слоями». Видимость растрового слоя настраивается так 

же, как и видимость векторного слоя.  

• Настройка масштабного эффекта слоя 

Для настройки масштабного эффекта слоя необходимо использовать 

окно «Управление слоями». Масштабный эффект растрового слоя 

настраивается так же, как и для векторного слоя, т.е. кнопкой 

«Оформление». 

• Настройка прозрачности слоя 

• Настройка яркости и контрастности слоя 

Эти настройки можно выполнить либо на уровне таблицы, либо на 

уровне слоя карты. В первом случае настройки сохраняются в таблице и 

вновь будут задействованы в следующих сеансах работы (команда Таблица → 

Растр → Подстройка изображения). Во втором случае настройки действуют 

только в текущем сеансе работы и только для заданного окна карты (окно 

«Управление слоями», кнопка «Оформление», режим «Единообразно»). 



6.4. Выполнение лабораторной работы 

Открыть карту мира и выполнить пространственную привязку 

растрового изображения World.tif. 



7. Лабораторная работа № 7. .Построение отчёта 

Цель работы 

Получить практические навыки работы создания и редактирования 

макета карты, добавления и редактирования отдельных элементов карты. 

7.1. Механизм отчетов  

Под отчетом в MapInfo понимается электронная версия документа, в 

котором могут содержаться фрагменты карт, списков, графиков, легенд и др., 

и который предназначен для вывода на печать.  

 

Рис. 47. Отчёт MapInfo 

Для работы с отчетами существует специальный тип окна — окно 

Отчета. Перейти к окну Отчёта можно выполнив команду Окно → Новый 

отчёт/ Window→New Layout Window. При работе с отчетом используются 

принципы векторной графики, а сам отчет состоит из различных объектов. 

Основным типом объектов отчета является объект рамка. Рамка представляет 

собой прямоугольник, заполненный содержимым какого-либо окна MapInfo: 

карты, списка, легенды или графика. Таким образом, чтобы поместить в 

отчет карту необходимо:  

1. Сформировать окно карты.  

2. Создать объект рамка, ссылающийся на эту карту.  



Для создания рамок необходимо использовать инструмент «Рамка»/ 

«Frame» , расположенный на панели «Пенал»/ «Drawing». В отчете могут 

размечаться также произвольные векторные примитивы, нарисованные 

пользователей — точки, линии, прямоугольники, области, текст. Навигация 

по отчету осуществляется подобно навигации по карте. 

 

Рис. 48. Определение параметров создаваемой рамки 

7.2. Модификация отчётов 

Под модификацией отчетов подразумевается:  

1. Изменение размеров отчета. 

Для изменения размеров отчета необходимо выполнить команду Отчет 

→ Режимы показа и выбрать необходимые размеры в разделе «Размер 

отчета». 

 

Рис. . Режимы показа отчёта 

Важно помнить, что размер отчета задается в числе страниц по ширине 

и высоте. При этом размеры самой страницы зависят от настроек текущего 

принтера. Например, можно распечатать отчет формата A1 на принтере 



формата А4, увеличив число страниц отчета. При этом каждая страница 

будет напечатана отдельно, страницы потом можно склеить. 

2. Изменение положения объектов отчета.  

Для изменения положения объектов отчета можно просто перемещать 

объекты инструментом выбора. 

3. Изменение свойств и стилей объектов отчета.  

Для изменения свойств и стилей объектов отчета необходимо 

выполнить команду Правка → Геоинформация (или двойной щелчок). Для 

изменения внутреннего заполнения рамки необходимо изменить содержимое 

самого окна, на которое ссылается рамка. Для сохранения отчета и 

продолжения работы с ним в следующем сеансе необходимо сохранить 

рабочий набор. 

7.3. Экспорт отчётов 

Созданный отчет может быть экспортирован во внешний файл. Для 

этого необходимо сделать окно отчета активным и выполнить команду Файл 

→ Экспорт окна. Имеется возможность сохранять окно в растровые и 

векторные форматы. Рекомендуется сохранять отчет в векторном формате 

EMF. 

7.4. Выполнение лабораторной работы 

Создайте отчёт представляющий карту плотности населения штатов 

Мексики, а так же отражающий данные о плотности населения стран мира. 

 


